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For Your Reference… 
To create a new database file: 

1. Click on the File tab and click on New 
2. Click on Blank database, type the File 

Name, click on [Browse] and choose a save 
location 

3. Click on [OK] then click on [Create] 

Handy to Know… 
• All new Access 2016 database files will be 

saved in the same format as Access 2007 
and 2010 files (.accdb). If you need to 
provide the file to other users who may be 
using earlier versions, you can save it as an 
Access 2003 or earlier file (.mdb), but the file 
may lose some functionality. 

CREATING A NEW DATABASE FILE 
 

In Microsoft Access 2016 all elements of your 
database; tables, reports, forms, and the like, are 
stored in one file with the file extension accdb. 
This is what is commonly referred to as the 

database file – not to be confused with the tables 
where your data is stored. Before you can create 
tables, or reports, or forms, or any other object, you 
need to create a new database file. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Be sure to click on the Close button for the 
database object when closing tables, queries, forms 
etc – if you click on the Close button in the very top 
right corner, you will close Access 

 
 
 
 
 
 
 
 
 
 
 

Try This Yourself: 
 Before you begin, ensure 

that Access has started... 

1 Click on the File tab to 
display the New area in 
the Backstage 

2 Click on the Blank 
desktop database 
template and type 
Expense System in File 
Name 

We’ll save it where the 
other course files are 
located… 

3 Click on [Browse] to 
display the New 
Database dialog box, 
then locate and click on 
the Course Files for 
Microsoft Access 2016 
folder and click on [OK] 
The course files folder is 
now where the database 
will be saved… 

4 Click on [Create] to 
create the new database 

5 Click on Close to close 
the automatic table 
(Table1) that has 
appeared 

 



LAB 25: CREATING DATA TABLES / PROPERTIES OF THE FIELDS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 2
 

 

 

For Your Reference… 
To create a new table: 

1. Click on the Create tab, then click on Table 
Design in the Tables group 

2. Type the Field Name, select a Data Type 
and type the Description for each field 

Handy to Know… 
• When you click on a field in the table Design 

window, the Properties for that field are 
displayed in the lower half of the window. 
The number and type of properties that you 
see will vary depending on the data type of 
the field. 

CREATING LOOKUP TABLES 
 

The lookup table holds the records that will be 
looked up by the transaction table. In this 
example, the lookup table holds Employee 
records. Creating a lookup table involves creating 

the fields in the table and specifying their size and 
type. The fields will hold the employee details that 
are needed for our database but are not relevant to 
specific expense transactions. 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

FirstName 15 
LastName 25 
Department 25 

 
 
 
 
 
 
 

 Field Sizes to change: 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Relational 
Databases_1.accdb... 

1 Click on the Create tab, 
then click on Table Design 
in the Tables group to 
display a new table 

2 Type EmpNo in Field 
Name, then press  to 
move to Data Type 

3 Click on the drop arrow for 
Data Type and select 
Short Text, if necessary, 
then press  to move to 
Description 

4 Type Records the 
employee number 

5 In the Field Properties at 
the bottom of the Table1 
window, select the value in 
Field Size and type 6 

6 Click in the row under 
EmpNo to start a new field, 
then repeat steps 2 to 5 to 
create the additional fields 
with Field Sizes, as shown 

Leave the table design on 
the screen for the next 
exercise 
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For Your Reference… 
To define a primary key for a table: 

1. In table Design View, click on the field that 
will be used as the primary key 

2. On the Table Tools: Design tab, click on 
Primary Key in the Tools group 

Handy to Know… 
• Once you have nominated a field as the 

primary key, Access will only allow you to 
enter unique values in that field. Duplicate 
values or empty fields (known as nulls) will 
not be accepted. AutoNumber field types 
are ideal for primary keys because they are 
automatically created and are always unique. 

DEFINING A PRIMARY KEY 
 

For a lookup database to be useful, it must be 
able to retrieve data quickly and easily. In 
addition, it must be able to pull data from different 
tables together quickly to provide information. To 

make this possible, each table should include a 
field or set of fields that makes each record in the 
table unique. This field or set of fields is known as 
the primary key. 

 
 

 

Try This Yourself: 
 Before starting this 

exercise, ensure that the 
table design from the 
previous exercise is 
displayed... 

 A primary key is 
indicated by a key 
symbol. Currently, this 
table does not have a 
primary key assigned… 

1 In table Design View, 
click on EmpNo in Field 
Name to select the field 

2 On the Table Tools: 
Design tab, click on 
Primary Key in the 
Tools group 

A small key icon will 
appear to the left of the 
selected field to indicate 
that it is the primary key 
field. 

Leave the table design 
on the screen for the 
next exercise 
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For Your Reference… 
To save a table design: 

1. Click on the File tab to display the 
Backstage, then click on Save 

2. Type a Table Name and click on [OK] 

Handy to Know… 
• If you try to close a table that has been 

modified but not saved, Access will prompt 
you to save the changes and provide a 
dialog box so that you can choose [Yes] or 
[No]. 

SAVING AND CLOSING A TABLE 
 

Unlike data that is saved as you move away from 
a field, tables are objects that must be saved if 
you want to retain any changes that you make to 
the design. You can either save the table as you 

work or save it as you close it. One advantage of 
this process is that if you want to return to the 
previous settings, you can simply close the table 
without saving it. 

 
 

 

Try This Yourself: 
 Before starting this exercise, 

ensure that the table design 
from the previous exercise is 
displayed... 

1 Click on the File tab, then click 
on Save to display the Save 
As dialog box 

We selected Save, not Save 
As, because the Save As 
options relate to the database 
as a whole and we are only 
saving an object within the 
database at this point. Unlike 
larger Save As dialog boxes 
found in other applications, this 
box is relatively small. This is 
because the table structure is 
saved as part of the database 
file so there is no need to 
specify a file location for 
database objects… 

2 Type Employees in Table 
Name, then click on [OK] 
The table’s name will now 
appear in the Navigation 
pane… 

3 
Click on Close to close the 
table 
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For Your Reference… 
To create an expense type table: 

1. On the Create tab, click on Table Design in 
the Tables group 

2. Specify the fields and the primary key, then 
click on Save in the QAT 

Handy to Know… 
• The AutoNumber field type provides an 

automatic and unique number for each 
transaction. It is ideal for tasks where you 
need to have a new and unique number for 
each transaction record that is entered into 
the table. 

CREATING THE EXPENSE TYPE TABLE 
 

The relational database in our case study 
actually requires two lookup tables. The first is 
used for the Employees entity, while the second 
is used for the Expense Type entity. In the 

Expense Type lookup table, information is entered 
about types of transactions which can be then later 
looked up from the transactions table. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Relational 
Databases_2.accdb... 

1 Click on the Create tab, 
then click on Table Design 
in the Tables group to open 
a new table 

2 Type the fields as shown 
(set the Field Size for the 
Description field to 30) 

3 Click on ExpTypeNo in 
Field Name to select the 
field, then on the Table 
Tools: Design tab, click on 
Primary Key in the Tools 
group to make this field the 
primary key 

4 Click on Save in the Quick 
Access Toolbar (QAT) to 
display the Save As dialog 
box 

5 Type Expense Type in 
Table Name, then click on 
[OK] 
The new table is listed in 
the Navigation pane and 
the object name appears in 
the tab at the top of the 
design window… 

6 Click on Close to close the 
table 
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For Your Reference… 
To create a transaction table: 

1. On the Create tab, click on Table Design in 
the Tables group 

2. Specify the fields and the primary key, then 
click on Save 

Handy to Know… 
• When one table (e.g. TableA) links to an 

Autonumber field in a lookup table (e.g. 
TableB), that field should be defined as 
numeric in TableA as this allows you to 
enter the correct number for the item in the 
lookup table. 

CREATING THE TRANSACTIONS TABLE 
 

Once you have created the lookup tables for your 
relational database, you can turn your attention 
to creating the transaction table or tables. There 
is nothing different or special about creating a 

transaction table from creating a lookup table – you 
still need to enter and define the fields, identify a 
primary key and name the table. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Relational 
Databases_3.accdb... 

1 Click on the Create tab, then 
click on Table Design in the 
Tables group to open a new 
table 

2 Type the fields as shown (set 
the Field Size for the EmpNo 
field to 6) 

3 Click on ExpTransNo in Field 
Name to select the field, then 
on the Table Tools: Design 
tab, click on Primary Key in 
the Tools group to make this 
field the primary key 

4 Click on Save in the QAT to 
display the Save As dialog box 

5 Type Expense Transactions 
in Table Name, then click on 
[OK] 
The new table is listed in the 
Navigation pane and the object 
name appears in the tab at the 
top of the design window… 

6 Close the table 
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 Field Sizes to change: 

 

For Your Reference… 
To create a details table: 

1. Click on the Create tab, then click on Table 
Design in the Tables group 

2. Type the field names, field types and field 
descriptions, then set a primary key 

3. Save and close the table 

Handy to Know… 
• A phone number field should be defined as a 

text field even though it consists of numbers 
because telephone numbers are not used in 
calculations. 

CREATING THE DETAILS TABLE 
 

In our case study database specification we 
required a table that will hold personal details of 
the employees in our system. This table is like an 
addendum to the main Employees table – it is 

neither a lookup table nor a transaction table. It is 
generally best to create these details tables last. 

 
 

 

EmpNo 6 
HomePhone 12 
NextOfKin 20 
Relationship 20 

 
 
 
 
 
 
 
 

3  Note: In reality, NextOfKin should probably be two fields (for first 
and last name), but we have kept it short for the purposes of this 
case study. 

 
 

 

 
 
 
 
 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Relational 
Databases_4.accdb... 

1 Click on the Create tab, 
then click on Table 
Design in the Tables 
group to create a new 
table 

2 Create the fields with 
Field Sizes, as shown 

3 Click on EmpNo in 
Field Name to select 
the field, then on the 
Table Tools: Design 
tab, click on Primary 
Key in the Tools group 
to make this field the 
primary key 

4 Click on Save in the 
QAT to display the Save 
As dialog box 

5 Type Personal Details 
in Table Name, then 
click on [OK] 

6 Close the table 
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For Your Reference… 
To open an existing table: 

• Double-click on the table in the Navigation 
pane, or 
Right-click on the table to see a shortcut 
menu and select the appropriate command 

Handy to Know… 
• There is no right or wrong way to open a 

table. Choose either the Navigation pane 
double-click method or the right-click method 
as suits. 

OPENING AN EXISTING TABLE 
 

Tables exist within a database file as database 
objects. When you work with a table you usually 
work with its data – this is done in a special table 
view known as Datasheet view. If you want to 

modify the structure of a table or one of its fields 
you must work with the table in Design view. 

 
 

 

Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST open 
the file Modifying 
Tables_1.accdb… 

1 In the Navigation pane, 
double-click on the 
Employees table to open 
the table in Datasheet 
view 

2 On the Home tab, click 
on the top half of View in 
the Views group to 
switch to Design mode 

Note that the picture on 
the View tool changes to 
indicate the view you will 
be toggled to… 

3 Click on View again to 
toggle back to Datasheet 
view 

4 Click on Close to the 
right of the table to close 
it 

5 In the Navigation pane, 
right-click on the 
Employees table to 
display the shortcut menu 

6 Select Design View to 
display the table in 
Design view 

7 Close the table 
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For Your Reference… 
To add another field to a table: 

1. Click on the field above which you wish to 
insert the new field 

2. On the Table Tools: Design tab, click on 
Insert Rows in the Tools group 

Handy to Know… 
• Some words are reserved for key operations 

in Access and can’t be used for field names. 
One such word is Date – Access will warn 
you if you attempt to use a reserved word as 
a field name. 

ADDING FIELDS TO AN EXISTING TABLE 
 

Your database design may have been perfect 
when you first created it, but after reviews with 
end-users and managers, and even after some 
additional reflection or brain waves, it may 

become necessary to tweak the field structure. 
Fortunately, modern database applications like 
Access allow you to add fields to an existing table 
with minimal effort. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_1.accdb... 

1 In the Navigation pane, 
right-click on the 
Employees table and 
select Design View to 
display the table in 
Design view 

2 Click on the Started 
field then, on the Table 
Tools: Design tab, click 
on Insert Rows in the 
Tools group to add a 
new field row 

3 Enter the details as 
shown and change the 
Field Size property to 
30 

4 Repeat steps 2 and 3 to 
add a PhoneNo field as 
shown, with a Field Size 
of 15 

5 Click on Save in the 
Quick Access Toolbar 
to save the design 
changes 

6 Click on Close to close 
the table 
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UNDERSTANDING FIELD PROPERTIES 
 

Fields in a table structure have specific 
characteristics that can be modified to adjust how 
the field is displayed on the screen, what it is 
named, and even what can be entered into it. 

These characteristics are known as properties and 
appear at the bottom of the Design view screen 
when a field is selected. They can become very 
powerful tools when used correctly. 

 
 

 

Field Properties 
The properties of fields vary depending upon the data type of the field. For example, you can’t 
change the width of a numeric field, but you can for a text field. The list of properties, therefore, 
should be watched carefully to see just what is available to you. 
The following list shows the more common field properties that appear when you click on a field in 
Design view. If one of the properties below fails to appear when a field is clicked, then that property is 
not available to the data type of the selected field. 

 
Field Size Limits the size of Short Text fields. It can be set from 1 to 255. Be careful 

changing the size of fields if records have already been entered into the table. 

New Values Appears only for AutoNumber fields and allows you to specify the increment 
value between new numbers. 

Format Allows you to change how numbers and dates are displayed. If you have 
formatted numbers in Microsoft Excel, then the formats used here will be 
familiar to you. 

Input Mask Allows you to force data entry into predefined formats, such as phone numbers 
(e.g. (03) 9851 4000) where brackets, spaces, dashes etc are used for the 
data. 

Caption Captions are used in forms and reports in lieu of the normal field name. 
Captions are handy when you have used truncated or abbreviated field names 
(e.g. EmpNo can be made to appear as Employee Number). 

Decimal Places Allows you to specify the number of decimal places for numeric fields. 

Default Value Allows you to specify a default value that will appear in the field whenever a 
new record is created. This can be standard text or, in the case of dates, can be 
an expression (i.e. a formula) that displays the current date. 

Validation Rule Allows you to specify a rule for the data to ensure that data is entered correctly. 
For example, you can specify a rule that a number has to be greater than 1,000 
or that the date must be today or later etc. 

Validation Text Displays a message to the user when data entered into a field with a validation 
rule doesn’t match what the validation rule requires. 

Required Ensures that data is entered into the field. Access will not move off the record 
until data has been entered into the field. 

Allow Zero 
Length 

If nothing is entered into a text field it is deemed to be of null length. If you wish 
to enter an empty string (“ “) you must select this property. Note that this is an 
advanced concept. 

Indexed Indexes are used to list data in a specific order, speed up searching, and/or 
restrict the entry of duplicate values. They will be explained in greater detail 
later. 

Smart Tags Smart Tags are used to obtain specific data for the field. They can be used to 
obtain stock quotes, exchange rates, etc. Again, they are an advanced concept. 

Text Align Allows you to determine where in a column (left, centre or right) data will 
appear. 
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For Your Reference… 
To change the size of a field: 

In Design view, click on the field to select it 
Double-click on the value for Field Size in 
Field Properties 
Type a new value and press 

Handy to Know… 
• Generally you won’t have too many problems 

if you increase field size. However, if you 
decrease field size and there are records in 
the table you may find you will lose some 
data. 

CHANGING FIELD SIZE 
 

By rights you should have determined the 
appropriate size of a field during the design 
phase. However, you can alter the size of a field 
at any time in Design view. To change the field 

size all you need to do is to specify a new value in 
the Field Size property of the relevant field. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_2.accdb... 

1 In the Navigation pane, 
right-click on the 
Employees table and 
select Design View to 
display the table 

2 Click on the Location 
field, then double-click 
on 30 in Field Size in the 
Field Properties pane at 
the bottom of the window 

3 Type 40 and press  
to increase the size 

4 Click on the PhoneNo 
field, then double-click 
on 15 in Field Size 

5 Type 6 and press  

6 Save and close the table 
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For Your Reference… 
To change the name of a field: 

In Design view, double-click on the field to 
place it into edit mode 
Type the new name and press 

Handy to Know… 
• Rather than changing the column heading, 

and therefore the field name, you can use 
the Caption property in Table Design view. 
This provides an alternative name for a field 
when it is displayed in a table. 

CHANGING FIELD NAMES 
 

There is much debate regarding the naming of 
fields. Again, field names are something that 
should really be sorted out before the structure is 
created and then they should be rigidly adhered 

to. However, if you have to you can easily change 
the name of a field in Design mode. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_3.accdb... 

1 In the Navigation pane, 
right-click on the 
Employees table and 
select Design View to 
display the table 

2 Double-click on the 
Location field to place its 
name in edit mode 

3 Type EmployeeLocation 
and press  

This name reflects a 
traditional approach to 
field naming, where 
spaces are excluded and 
multi-word names have 
each word beginning with 
a capital letter… 

4 Save and close the table 
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For Your Reference… 
To change decimal places: 

1. In Design view, click on the field to format 
2. In the Field Properties pane, click on the 

value in Decimal Places, click on the drop 
arrow and select the number of decimal 
places you require 

Handy to Know… 
• Some data types, such as Currency, have a 

predefined number of decimal places. 

CHANGING DECIMAL PLACES 
 

Numbers can be used in databases for a variety 
of reasons. They can record values, sizes, areas, 
volumes, temperatures and so on. Each field 
containing a number may require specialised 

formatting. While some formats are taken from the 
data type, such as Currency, other numbers may 
require adjustment of decimal places to correctly 
represent their value. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_4.accdb... 

1 In the Navigation pane, 
right-click on the 
Employees table and 
select Design View to 
display the table 

2 Click on the 
WeeklyHours field to 
display its properties in 
the Field Properties 
pane 

3 Click on the value in 
Decimal Places, then 
click on the drop arrow 
and select 1 

The drop arrow appears 
at the very right end of the 
field in the Field 
Properties pane… 

4 Save and close the table 
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For Your Reference… 
To change the date format of a field: 

1. In Design view, click on the field to format 
2. Click on Format in the Field Properties 

pane, then click on the drop arrow 
3. Select the date format 

Handy to Know… 
• Terms such as long date and medium date 

can be rather meaningless to most people. In 
the Field Properties pane, the sample to the 
right of the list of date formats can be used 
as a guide to see how date formats will 
appear. 

CHANGING DATE FORMATS 
 

Dates may be stored in tables for a variety of 
reasons. They may include dates of birth, starting 
dates, expiry dates, or the dates of milestones. 
Access allows you to display dates in a variety of 

formats – depending on the needs of your 
application. You can choose between Long Date, 
Medium Date, General Date, Short Date, and 
various time-only formats. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Tables_5.accdb... 

1 In the Navigation pane, 
right-click on the Employees 
table and select Design View 
to display the table 

2 Click on the Started field to 
display the Field Properties 

3 In the Field Properties pane, 
click in Format, then click on 
the drop arrow and click on 
Medium Date 

4 Repeat steps 2 and 3 for the 
DateOfBirth field 

5 Save and close the table 
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For Your Reference… 
To create an index on a field: 

1. In Design view, click on the field to index 
2. Click on Indexed in the Field Properties 

pane, then click on the drop arrow 
3. Select the required indexing option 

Handy to Know… 
• You can specify an index for a LastName 

field as Duplicates OK because there might 
be more than one employee with the same 
last name. A PhoneNo field, however, 
should be indexed as No Duplicates 
because every employee should have a 
different phone number. 

INDEXING FIELDS  

Because indexes help to speed up data retrieval, 
you can create indexes on fields that you expect 
to sort or search on frequently. Indexes can also 
be used to prevent duplicate data from being 

typed into the table. When you specify that a field 
should be indexed, you can specify it as 
Duplicates OK or No Duplicates depending upon 
the requirements of the field being indexed. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_6.accdb... 

1 Ensure the Employees 
table is displayed in 
Design View 

2 Click on the LastName 
field to display the Field 
Properties pane 

3 Click on Indexed, then 
click on the drop arrow 

4 Select Yes (Duplicates 
OK) if it isn’t already 
selected 

5 Click on the PhoneNo 
field to display its 
properties 

6 Click on Indexed, click on 
the drop arrow and select 
Yes (No Duplicates) 

7 Save and close the table 
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For Your Reference… 
To delete a field from a table: 

1. In Design view, click on the field to delete 
2. On the Table Tools: Design tab, click on 

Delete Rows in the Tools group 

Handy to Know… 
• If you accidentally delete a field that you 

need, close the table without saving the 
changes. Deletions only come into effect 
when the table is saved. 

DELETING FIELDS FROM A TABLE 
 

Like adding fields to a table, deleting fields really 
shouldn’t be necessary if the designing has gone 
to plan. However, if you need to delete a field 
from a table it can be done with relative ease. 

You do need to be aware that deleting a field from 
a table that has records in it will result in data loss. 
Therefore before deleting fields in an existing table 
you should make adequate backups. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Tables_7.accdb... 

1 In the Navigation pane, 
right-click on the 
Employees table and 
select Design View 

2 Click on the 
EmployeeLocation field 
to select it 

3 On the Table Tools: 
Design tab, click on 
Delete Rows in the 
Tools group 

The field is deleted from 
the table structure… 

4 Save and close the table 
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For Your Reference… 
To copy a table within a database file: 

1. In the Navigation pane, right-click on the 
table and select Copy 

2. On the Home tab, click on the top half of 
Paste 

3. Complete the dialog box options and click on 
[OK] 

Handy to Know… 
• Your database file will grow in size if you add 

copies of your tables. If you have a number 
of tables in the database file it may be more 
effective to make a backup copy of the 
database file rather than the tables. 

COPYING A TABLE WITHIN A DATABASE 
 

When you make structural changes to a table 
which can involve data loss, it is a good idea to 
make a back-up of the table first. You could back 
up the entire database file using conventional file 

copy operations in File Explorer, however, a 
quicker and easier way is simply to make a 
duplicate copy of the table within the database file 
itself. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or 
open the file Modifying 
Tables_8.accdb... 

1 In the Navigation pane, 
right-click on the Employees 
table and select Copy to 
copy the table to the 
clipboard 

2 On the Home tab, click on 
the top half of Paste in the 
Clipboard group to display 
the Paste Table As dialog 
box 

This dialog box allows you to 
determine what to copy and 
how to name it… 

3 Ensure Structure and Data 
is selected, then click on 
[OK] to paste a copy of the 
table 

Let’s give it a more 
descriptive name… 

4 Right-click on the Copy of 
Employees table and select 
Rename to place the name 
in edit mode 

5 Type Employees Backup, 
then press  
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For Your Reference… 
To delete a table from a database file: 

1. In the Navigation pane, right-click on the 
table and select Delete 

2. Click on [Yes] to delete the table 

Handy to Know… 
• Deletion of a table is final – there’s no way 

back. It is a good idea therefore to make a 
back-up copy of the database file before 
deleting tables (or indeed, other objects) 
from the database. 

DELETING A TABLE FROM A DATABASE FILE 
 

Tables are simply objects stored within a 
database file. As such you can create them, 
modify them, and even delete them if so required. 
In general terms the only time you should really 

need to delete a table is when you no longer 
require copies of tables made for back-up and data 
protection purposes. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the 
file Modifying 
Tables_9.accdb... 

1 In the Navigation 
pane, right-click on the 
Employees Backup 
table and select 
Delete 
A deletion warning 
message will display… 

2 Click on [Yes] to 
delete the table 

The deleted table will 
no longer appear in 
the Navigation pane 
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UNDERSTANDING TABLE RELATIONSHIPS 
 

In a relational system the database is normally 
made up of several tables that store your data. 
Where multiple tables exist they are linked or 
joined together, thereby forming a relationship 

which allows the system to add, update or report on 
the data contained in the tables as though they 
were one entity. 

 
 

 
 

Types of Relationships 
There are three types of relationships that can exist between tables: 
• one-to-one, where each record in a table is related to only one other record in another table – 

this is a rare form of relationship. 
• one-to-many, where one record in a table is related to many others in another table – this is 

the most common form of relationship and usually exists where one table is used to look up key 
values. In this type of relationship, the table with many records is often referred to as the 
transaction table, while the other table is known as the lookup table as it is used by the 
transaction table to lookup some data, usually a name, or a title, or something similar. 

• many-to-many, where many records in one table can be related to many records in another 
table – this is extremely rare and very problematic. 

 
Referential Integrity 

Referential integrity is probably the most significant benefit of relating tables. 

Let's consider two of the tables in our system, Expense Transactions and Employees. These 
tables can be related using a one-to-many relationship – there can be many expense transaction 
records for each employee. 

Since we need to know which employee raised a claim, it would be imprudent of our database if it let 
us create a new expense transaction without information about the employee. 

If we enforce referential integrity in the one-to-many relationship between the Expense 
Transactions and Employees table it will not be possible to enter a new expense record without 
assigning it to an employee record that exists in the Employees table. 

Referential integrity has some further options. For example if the EmpNo number for an employee 
changed it would be handy if Access would automatically update the number in all of the related 
tables – this can be done by activating Cascade Update. 

Similarly, if we delete an employee from the Employees table, we may wish to delete all of the 
expense transaction records for that employee from the system. This can be done by activating the 
Cascade Delete option – however, you should treat this with care and really examine the needs of 
your business before activating Cascade Delete. It is possible that you need to retain the expense 
records for a certain period of time, even if the employee has left. 

 
Relationships as Data Protection 

All of this theory is a lot of information to process. Look carefully at your data and you'll notice that 
these are only rules to protect your data and ensure that it remains updated and consistent. They 
also ensure that you don’t accidentally delete records that you need to keep. 
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UNDERSTANDING LOOKUP RELATIONSHIPS 
 

The most common reason for relating tables in a 
database file is for lookup purposes. Lookups 
are used when the details from single entity 
tables are required to be displayed in transaction 

tables, usually to assist in data entry or reporting. In 
our case study the expenses table uses the 
employee number, but to assist in data entry we 
need to display (i.e. lookup) the employee name. 

 
 

 

One-To-Many Relationships 
Lookup databases have a one-to-many relationship. 

In this type of relationship the lookup table contains unique records and forms the one side in the 
one-to-many relationship. The transaction table forms the many side in the one-to-many 
relationship because there may be many transactions for each record or entity from the lookup table. 

Lookups are done from the transaction table into the lookup table. 

In our case study we have two lookup requirements from the Expense Transactions table: one for 
employees and the other for expense types. 

With employees, the Employees table is the lookup table – there is only one record here for each 
employee. The Expense Transactions table is the transaction table – there may be many records 
for each of the employees in the Expense Transactions table. 

With expense types, the Expense Types table is the lookup table – there is only one record here for 
each type of expense that can be incurred. The Expense Transactions table is again the 
transaction table – there may be many records for each of the types in the Expense Type table. 

Table relationships are made possible by the use of the primary key in the lookup table. The role of 
the primary key is to keep records in order and to facilitate a fast search mechanism so that lookups 
appear almost instantaneously. The primary key is referenced from the transaction table using a 
lookup field, often with a similar name to that of the primary key in the lookup table. The value in 
the lookup field is used to search the primary key field in the lookup table and once found, data from 
other fields of the found record can be used. 

 

For example, with employees in our case study, the primary key of the Employees table is EmpNo 
and is used in that table to uniquely identify employees. For the relationships to work with Expense 
Transactions, there is a field called Employee. The value in the Employee field in the Expense 
Transactions table is used to look up the primary key field EmpNo in Employees for the correct 
employee. Once a match is made other details such as first name, last name etc. from Employees 
can be used for reports and displays such as drop-lists as shown above. 
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For Your Reference… 
To connect to a lookup table: 

1. Open the transaction table in Design View 
and click in the first blank row 

2. Click on Modify Lookups in the Tools group 
3. Follow the steps of the wizard and specify 

the relevant field details 

Handy to Know… 
• Relationships between tables can be done 

through the Lookup Wizard or you can 
create them manually in the Relationships 
pane. 

LOOKING UP THE EMPLOYEES TABLE 
 

Once you have created a transaction and a 
lookup table, you can connect the two tables to 
form a relationship between them. One of the 
easiest ways to do this is to use the Lookup 

Wizard to create a Lookup Column in the 
transaction table. The wizard enables you to 
nominate the fields from the lookup table that you 
want displayed with your transaction data. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this exercise 
you MUST open the file 
Creating 
Relationships_1.accdb… 

1 Open the table Expense 
Transactions in Design 
View 

2 Click on Short Text in Data 
Type for EmpNo, then click 
on the drop arrow and 
select Lookup Wizard to 
start the Lookup Wizard 

3 Work through the wizard, 
making the selections as 
shown 

4 Click on [Finish] to 
complete the wizard, then 
click on [Yes] to save the 
changes 

Notice the EmpNo field is 
now called Employee… 

5 Click on the Employee 
field, then click on the 
Lookup tab in the Field 
Properties pane to see the 
settings that have been 
created 

6 Close the table 

 

Screen Task Then 

1 Select I want the lookup field to get the 
values from another table or query 

[Next] 

2 Select Table:Employees [Next] 

3 Double-click on LastName then on FirstName 
in Available fields 

[Next] 

4 Select LastName for the first sort column, 
then FirstName for the second sort column, 
ensuring that both are set to Ascending order 

[Next] 

5 Ensure that Hide key column appears with a 
tick 

[Next] 

6 Type Employee as the label for the lookup 
field 
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For Your Reference… 
To connect to a lookup table: 

1. Open the transaction table in Design View, 
then click in a blank row 

2. Change the relevant field to a Lookup field 
3. Follow the steps of the wizard and specify 

the relevant field details 

Handy to Know… 
• The lookup operation is performed in Access 

using SQL programming code. The code that 
does this is in the Row Source field of the 
Lookup tab in Field Properties. It’s worth 
having a look at this code to see how it is 
written. 

LOOKING UP THE EXPENSE TYPES TABLE 
 

The second example of a lookup required in our 
case study database is one that looks up 
expense type details. The looking up is done 
from the transactions table and uses the expense 

type number as a lookup key. The wizard provides 
the quickest and easiest way of creating the 
lookup. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Relationships_2.accdb... 

1 Open the table Expense 
Transactions in Design 
View 

2 Click on Number in Data 
Type for ExpTypeNo, then 
click on the drop arrow and 
select Lookup Wizard to 
start the Lookup Wizard 

3 Work through the wizard, 
making the selections as 
shown 

4 Click on [Finish] to 
complete the wizard, then 
click on [Yes] to save the 
changes 

Notice the ExpTypeNo field 
has been changed to 
Expense Type… 

5 Click on the Expense Type 
field, then click on the 
Lookup tab in the Field 
Properties pane to see the 
settings that have been 
created 

6 Close the table 

 

Screen Task Then 

1 Select I want the lookup field to get the 
values from another table or query 

[Next] 

2 Select Table: Expense Type [Next] 

3 Double-click on Description in Available 
fields 

[Next] 

4 Ignore the sort order settings [Next] 

5 Ensure that Hide key column appears 
ticked 

[Next] 

6 Type Expense Type as the label for the 
lookup field 
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For Your Reference… 
To view table relationships: 

1. Click on the Database Tools tab 
2. Click on Relationships in the Relationships 

group 

Handy to Know… 
• If you need a hard copy of the table 

relationships, click on the Relationship 
Tools: Design tab and click on 
Relationship Report in the Tools group. 
Click on the File tab to display the 
Backstage, select Print and click on Quick 
Print to print the report. 

VIEWING TABLE RELATIONSHIPS 
 

Table relationships can be viewed and edited 
using the Relationships window. This window 
gives you a better understanding of how tables 
are related or joined together. It also lists all of 

the fields in each table so that you can locate 
content easily. The Relationships window can be 
used to document part of your database design by 
printing it as a report. 

 
 

 

IMPORTANT: 
Additional tables may 
display such as the 
MSysNavPaneGroups 
table. These are 
hidden system objects 
that keep track of the 

 
are grouped. To 
continue with the 

 
right-clicking on the 
Navigation pane, 
selecting Navigation 
Options, then clicking 
on Show Hidden 
Objects and Show 
System Objects so 
they both appear 
unticked. If this doesn’t 

 
table and select Hide. 

 
 

 

 

way database objects 

exercise, hide them by 

work, right-click on the 

 
Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Relationships_3.accdb... 

1 Click on the Database 
Tools tab, then click on 
Relationships in the 
Relationships group 

The existing 
relationships between 
tables will be shown. 

2 On the Relationship 
Tools: Design tab, click 
on Show Table in the 
Relationships group to 
display the Show Table 
dialog box 

3 Double-click on 
Personal Details to add 
the table, then click on 
[Close] 
The lines that appear 
are join lines showing 
the table relationships… 

4 Use the mouse to drag 
the tables into position 
as shown 

5 Save and close the 
Relationships window 
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UNDERSTANDING TABLE JOINS 
 

While the actual process of joining tables in a 
relational database in Microsoft Access is easy, a 
reasonable degree of thought should be devoted 
before making the joins. In our case study we 

have four tables which will need to be joined. A little 
understanding of what types of joins we need and 
why we are using them is useful before proceeding 
much further. 

 
 

 

While the Relationships window is open, the quickest way to create a relationship is to drag the mouse 
from one field in a table to another field in a different table. The process is very simple and easy to do. 
For example, in the design of our Expenses System we have a transaction table that contains expense 
transactions (Expense Transactions) and another that contains details about our employees 
(Employees). 

 

 
This structure ensures that we don't re-enter employee details every time an employee has an expense to 
claim for – instead, we use the EmpNo number as a code to look up the employee details in the 
Employees table. 
Let's stop and consider what we are doing. With this relationship we are telling Microsoft Access that 
there will be one employee record in Employees and many in Expense Transactions. The two tables 
are related by the common field of EmpNo. In the Employees table the EmpNo field is the primary key 
– it is unique, there can only be one EmpNo number for each employee (remember, it appears with a key 
icon because it is the primary key). 
From a design perspective we are creating a one-to-many relationship. To do this, the link field in the one 
table must be the primary key. The link field in the many table becomes known as the foreign key. 

 
 
 

When a join is created in Microsoft Access, 
a line appears between the related fields in 
the two tables. The symbols on the line tell 
you what type of join it is. The infinity symbol 
indicates that the Expense Transactions 
table is a many table, while the one symbol 
indicates that the Employees table is a one 
table. 

 
 
 

We have several other issues to consider here. 
Should we enforce referential integrity? If we want to stop an expense record being created that is not 
linked to an existing employee, then the answer is yes. 
If we opt for referential integrity, do we want all of the EmpNo numbers in expenses to update when we 
change the EmpNo in Employees? If the answer is yes we must activate Cascade Update. 
Again, if we want all of the expenses for an employee to be deleted when we delete the employee from 
the Employees table, we must activate Cascade Delete. 
Naturally, these questions will need to be asked for all of the joins that we create between all of the tables 
in the system. 



LAB 25: CREATING DATA TABLES / PROPERTIES OF THE FIELDS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI 

 

Pa
ge

 2
5 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Relationships_4.accdb... 

1 On the Database Tools tab, 
click on Relationships in the 
Relationships group 

2 Click on the join line between 
the Expense Transactions 
and Employees tables to 
select it – it should appear 
slightly thicker 

3 On the Relationship Tools: 
Design tab, click on Edit 
Relationships in the Tools 
group to display the Edit 
Relationships dialog box 

4 Click on Enforce Referential 
Integrity until it appears with a 
tick 

5 Click on Cascade Update 
Related Fields until it appears 
with a tick 

6 Ensure Cascade Delete 
Related Fields appears 
without a tick 

7 Click on [OK] to apply the 
changes 

The symbols on the join 
indicate a one-to-many 
relationship… 

8 Close the Relationships 
window 

 

 

For Your Reference… 
To edit relationship joins: 

1. Click on the join line to select it 
2. On the Relationship Tools: Design tab, 

click on Edit Relationships in the Tools 
group 

3. Make the changes as appropriate 

Handy to Know… 
• In a one-to-many relationship where 

referential integrity is enforced, you cannot 
enter a record into the many (transaction) 
table unless the related (linked) field has 
been entered into the one (lookup) table as a 
record. The integrity of the relationship is 
thereby enforced (watched). 

EDITING THE EMPLOYEE TABLE JOIN 
 

Joins created using the Lookup Wizard use the 
common join settings. They do not however have 
any referential integrity settings in place. If you 
want to establish integrity between the tables you 

will need to edit the join in the Relationships 
window. In our case study we want to ensure that 
updates are reflected from the Employees table. 
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Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Relationships_5.accdb... 

1 On the Database Tools tab, 
click on All Relationships in 
the Relationships group 

2 Click on the join line between 
the Expense Transactions 
and Expense Type tables to 
select it – it should appear 
slightly thicker 

3 On the Relationship Tools: 
Design tab, click on Edit 
Relationships in the Tools 
group to display the Edit 
Relationships dialog box 

4 Click on Enforce Referential 
Integrity until it appears with a 
tick 

5 Click on Cascade Update 
Related Fields until it appears 
with a tick 

6 Ensure Cascade Delete 
Related fields appears 
without a tick 

7 Click on [OK] to apply the 
changes 

8 Close the Relationships 
window 

 

 

For Your Reference… 
To edit relationship joins: 

1. Click on the join line to select it 
2. On the Relationship Tools: Design tab, 

click on Edit Relationships in the Tools 
group 

3. Make the changes as appropriate 

Handy to Know… 
• If you want linked transactions to be deleted 

when a record is deleted in a lookup table, 
tick Cascade Delete in the Edit 
Relationships dialog box – but do not tick it 
if you want to keep the transactions (e.g. for 
accounting purposes). 

EDITING THE EXPENSE TYPE TABLE JOIN 
 

We should also set the referential integrity 
options for the join between the Expense 
Transactions and Expense Type tables. Since 
these tables form a one-to-many type of 

relationship, referential integrity will ensure that we 
can’t enter a record in the transactions table 
without a relevant entity in the lookup table. 
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For Your Reference… 
To create a new join between tables: 

1. Drag one joining field onto the other 
2. Choose the appropriate degree of referential 

integrity required 
3. Click on [Join Type] and specify the desired 

type of join 

Handy to Know… 
• When creating a new join manually, the 

default join type, where only rows that 
appear in both tables are included, is known 
as an inner join. If you want to see all 
records in the main table, irrespective of 
whether there is a related record in the linked 
table, create a left outer join. 

CREATING A NEW JOIN 
 

Not all tables are joined using the Lookup 
Wizard. Indeed, once you are proficient with the 
way joins work, you’ll probably find yourself 
manually creating your own joins. In our case 

study we need to establish a join between the 
Employees table and the Employee Details table 
– this will be a one-to-one join type. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous file 
with this exercise, or open the 
file Creating 
Relationships_6.accdb... 

1 On the Database Tools tab, 
click on Relationships in the 
Relationships group 

2 Click on EmpNo in the 
Employees table, then drag and 
drop the field on EmpNo in the 
Personal Details table 

This will open the Edit 
Relationships dialog box… 

3 Ensure that the three referential 
integrity boxes appear with a tick 

4 Click on [Join Type] to see the 
Join Properties dialog box 

5 Click on option 2: to create a left 
outer join where ALL employee 
records will be displayed 

Employees is the dominant table 
and we always want to see the 
records here… 

6 Click on [OK] to return to the 
Edit Relationships dialog box, 
then click on [Create] to create 
the join 

You might need to move the 
tables slightly to see the join… 

7 Save and close the 
Relationships window 
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For Your Reference… 
To produce a relationship report: 

1. Click on the Database Tools tab and click 
on Relationships in the Relationships 
group 

2. On the Relationship Tools: Design tab, 
click on Relationship Report in the Tools 
group 

Handy to Know… 
• A relationship report is actually created as an 

Access form. Even though you can save the 
report, there is little point in doing so unless 
you want to keep the current version of the 
relationships for your records. It takes so little 
time to create a new report, it’s just not worth 
the bother. 

CREATING A RELATIONSHIP REPORT 
 

Once all of your table relationships are created 
and have been refined the way you want, it is a 
good idea to document these relationships. The 
Relationships window allows you to produce a 

Relationship Report which is, in reality, a print 
preview version of the relationships window. For 
documentation purposes, you can then print this to 
either paper or a file. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Relationships_7.accdb... 

1 On the Database Tools 
tab, click on 
Relationships in the 
Relationships group 

2 On the Relationship 
Tools: Design tab, click 
on Relationship Report 
in the Tools group to 
create a report of the 
relationships 

The report appears as 
another tab in the 
database window… 

3 On the Print Preview tab, 
click on Print in the Print 
group to display the Print 
dialog box 

4 Ensure that your printer is 
online and ready to print, 
then click on [OK] 

5 Close the Relationships 
for… window without 
saving it 

6 Close the Relationships 
window 
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Kerr 

 

For Your Reference… 
To add a record to a table: 

Double-click on the table in the Navigation 
pane to open it in Datasheet view 
Type the data into each field, pressing 
to move across fields 

Handy to Know… 
• When entering data, long entries will appear 

truncated on the screen, but the complete 
data is stored in the field. 

• Records are saved automatically when you 
move to the next field or record. 

• To correct an error when adding a record, 
simply type over it. 

TYPING RECORDS IN A TABLE 
 

The easiest way to enter data is directly into an 
open table. When you open a table you are 
shown the Datasheet view by default. Access 
always displays the records in the table plus one 

additional row at the bottom of the table. This is the 
new record row where a new record can be 
entered. The total number of records, shown in the 
status bar, will increase as you add data. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

 

Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST 
open the file Adding 
Records_1.accdb… 

1 In the Navigation 
pane, double-click on 
the Employees table 
to open it 

The table will appear 
empty because no 
records have yet been 
entered. To enter a 
record, you type the 
data into each field 
and press  to 
move between the 
fields… 

2 Type the data as 
shown – use the 
mouse to click the 
check box for 
FullTime and press 

 to move through 
the fields 

3 Check that your data 
matches that shown 

4 Close the table 

 

 Record 1 Record 2 Record 3 

EmpNo: 101 102 103 

FirstName: Julianne Harry Angel 

LastName: Kerr Jones Harrington 

Department: Executive Executive Executive 

PhoneNo: 60001 60002 60003 

Started: 28/6/2010 19/7/2010 19/7/2010 

DateOfBirth: 5/2/1960 13/4/1965 19/8/1958 

FullTime: 
 

 
 

 
 

 

WeeklyHours 40 40 40 

Salary: $250,000 $140,000 $145,000 

Comments:    
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For Your Reference… 
To add records using a default form: 

1. Click on the table in the Navigation pane 
2. Click on the Create tab, then click on Form 

in the Forms group 
3. Click on the Home tab and click on View in 

the Views group 

Handy to Know… 
• When you click on Form on the Create tab, 

a default form is built from the table design 
and appears in Layout view, which allows 
you to change the layout of the form. You 
switch to Form view to work with the data, 
much the same as you switch to Datasheet 
view to work with data in a table. 

ADDING RECORDS USING A FORM 
 

Records can also be added to a table using a 
form. A form normally displays the details for one 
record on the screen at a time. It is like a card in 
a manual card file system. In Access you can 

create quite sophisticated forms for data entry and 
data display. You can also create a simple form for 
immediate data entry purposes using the Form 
command. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 The New (blank) record tool 

 

Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or open 
the file Adding 
Records_2.accdb... 

1 In the Navigation pane, click 
on the Employees table to 
ensure it is selected 

2 Click on the Create tab, then 
click on Form in the Forms 
group to display the first record 
of data in a form layout 

The form layout is like a 
structure. We need to be in 
Form view to work with the 
data… 

3 On the Form Layout Tools: 
Design tab, click on the top 
half of View in the Views 
group to display the form in 
Form view 

4 Click on New (blank) record 
in the bar at the very bottom of 
the form to display a new 
record – a yellow dotted 
square appears on this tool 

5 Type the three records, as 
shown, pressing  to move 
down the fields 

6 Close the form – since the 
form is a new object you will 
be asked if you wish to save it 

7 Click on [No] 

 

 Record 4 Record 5 Record 6 

EmpNo: 104 105 106 

FirstName: Peter Mark Maureen 

LastName: Dawson Jones Grayson 

Department: Executive Executive Administration 

PhoneNo: 60004 60005 61021 

Started: 19/7/2010 19/7/2010 6/9/2010 

DateOfBirth: 12/7/1954 6/8/1963 23/10/1974 

FullTime: 
 

 
 

 
 

 

WeeklyHours 40 40 40 

Salary: $140,000 $132,000 $85,000 

Comments:    
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Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or 
open the file Adding 
Records_3.accdb... 

1 In the Navigation pane, 
click on the Employees 
table to select it 

2 Click on the Create tab, 
then click on Form in the 
Forms group to display the 
first record of data in a form 
layout 

We won’t make any 
changes here (even though 
we could)… 

3 Click on the File tab to 
display the Backstage, then 
click on Save to display the 
Save As dialog box 

4 Type Employees Form in 
Form Name, then click on 
[OK] 
The form will now appear in 
the Navigation pane, under 
the Forms header… 

5 Close the form 

 

 

For Your Reference… 
To save a default form for reuse: 

1. Click on the table to select it, then click on 
the Create tab and click on Form in the 
Forms group 

2. Click on the File tab and click on Save 
3. Type a Form Name and click on [OK] 

Handy to Know… 
• Access uses headers (e.g. Tables, Forms, 

Reports etc.) in the Navigation pane to 
group the different objects, making it easier 
to differentiate and locate items quickly. This 
is particularly useful if two or more objects 
share the same name (e.g. Employees). 

SAVING A FORM LAYOUT FOR REUSE 
 

Default Forms are quick and easy forms created 
by Access to facilitate either data viewing or data 
entry. You can, if you wish, save default forms for 
future use. When you save a default form, a new 

form object is created which will appear in the 
Navigation pane. It can then be opened any time it 
is required. 
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Try This Yourself: 

 
Sa

m
e 
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 Continue using the 
previous file with this 
exercise, or open the file 
Adding 
Records_4.accdb... 

1 In the Navigation pane, 
double-click on 
Employees Form to open 
the form in Form view 

2 Click on New (blank) 
record in the bar at the 
very bottom of the form to 
display a new record 

3 Complete the new record 
as shown 

4 Click on Close to close 
the form 

 

 

 

For Your Reference… 
To add records using an existing form: 

1. Double-click on the form in the Navigation 
pane 

2. Click on New (blank) record and enter the 
desired data 

Handy to Know… 
• The navigation buttons at the bottom of the 

form can be used to display different records 
in the table. 

ADDING RECORDS USING AN EXISTING FORM 
 

Forms appear in the Navigation pane and are 
used to display data and make changes to data, 
including adding new records. It doesn't matter 
whether your form was created from a default 

form or from scratch, you use it in exactly the same 
way. To add a record using an existing form you 
open it, click on the new record button and start 
typing. 
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ADDING ADDITIONAL RECORDS 
 

Records can be added to a table directly by 
typing in the new record line of the opened table, 
or by using a form. The choice is entirely yours. 
In this section you'll have the opportunity to add 

more records using whichever technique you 
prefer, and to practise moving between the fields 
and records in a datasheet or form. 

 
 

 

Sub Heading 
Ensure you have completed the previous exercises and continue using the previous file, then open 
either the Employees table or the Employees Form and enter the data as shown below. It doesn’t 
matter in which order you type records. When a table is opened the records are always sorted according 
to the primary key. You can select or tick a checkbox using the keyboard rather than the mouse. Simply 
press to move to the checkbox then press to toggle on and off 

 
 
 
 

 Record 8 Record 9 Record 10 Record 11 Record 12 Record 13 

EmpNo: 108 109 110 111 112 113 

FirstName: Amanda George Neville Petra Vivienne Jerry 

LastName: Bennet Samuelson Smith Henricks Clark Hancock 

Department: Administration Administration Administration Administration Administration Administration 

PhoneNo: 61023 61024 61025 61026 61027 61028 

Started: 6/9/2010 6/9/2010 6/9/2010 6/9/2010 6/9/2010 6/9/2010 

DateOfBirth: 4/5/1959 1/12/1987 7/8/1954 3/4/1981 22/11/1961 9/10/1975 

FullTime: 
 

 
 

 
 

 
 

 
 

 
 

 

WeeklyHours 40 40 40 40 40 40 

Salary: $87,000 $98,000 $78,000 $82,000 $80,000 $79,000 

Comments:   Studying MBA    
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For Your Reference… 
To import records from Microsoft Excel: 

1. Click on the External Data tab, then click on 
Excel in the Import & Link group 

2. Browse for the file to import, click on [OK], 
then follow the wizard to complete the import 

Handy to Know… 
• The Import Wizard is by far the easiest way 

to import data and provides useful prompts 
along the way. Study each step carefully to 
see what options are available to you. 

• Importing can mess up data in a table – it is 
a good idea to make a backup of a table 
before importing into it. 

IMPORTING FROM MICROSOFT EXCEL 
 

Access can import data from a wide variety of 
applications, including Microsoft Excel. The key 
to importing successfully, is ensuring that the 
structure that you import from has the same field 

names as the table into which the data is to be 
placed. In our case study we are assuming that 
Alpheius Global Enterprises already has an 
employee data list in an Excel spreadsheet format. 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7 The Record count indicates that the table now contains 
104 records 

 
 
 

  

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Adding Records_5.accdb... 

1 Click on the Employees 
table to select it 

2 Click on the External Data 
tab, then click on Excel in 
the Import & Link group to 
display the Get External 
Data dialog box 

3 Click on [Browse], locate 
the file Employee List.xlsx 
in C:\Course Files for 
Microsoft Access 2016, 
then click on [Open] 

4 Click on Append a copy of 
the records to the table 
Employees, then click on 
[OK] to start the Import 
Spreadsheet Wizard 

5 Click on [Next] until you 
arrive at the last screen 

6 Click on [Finish], then click 
on [Yes] and [Close] to 
complete the operation 

7 Double-click on the 
Employees table to open it 
and see the data 

8 Click on Close to close the 
table 
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